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Installing Helix ALM
Perform the following steps to install Helix ALM based on your role.

User

Use the client-only installer to install the Helix ALM Client, SoloBug, and integration components.

Note: If you only use Helix ALMWeb, you do not need to install anything. Contact your Helix ALM
administrator if you need the URL or your username and password.

1. Before installing, review the Client System Requirements.

2. Download the client-only installer for your operating system.

3. Run the installer and select installation options. Only install the server admin utility if you administer Helix
ALM projects for your team.

4. After installation is complete, start Helix ALM, add a server connection, and log in.

Administrator

If you are an administrator responsible for configuring Helix ALM for your team, perform a complete
installation, which includes the Helix ALM Server, Helix ALM License Server, and client applications. If you
are upgrading Helix ALM, see Upgrading Helix ALM, page 3.

Note: If you are an administrator of a Helix ALM installation hosted by Perforce in the cloud, use the
client-only installer to install Helix ALM and the server admin utility.

1. Before installing, review the Client System Requirements and Server System Requirements.

2. Download the complete installer for your operating system.

3. Determine which components to install.

4. Run the installer and select installation options.

5. After installation, start and configure the license server, and then start and configure the Helix
ALM Server.

Depending on how your organization uses Helix ALM, youmay also need to perform the following tasks:

n Configure web servers for web clients

n Move existing projects
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Upgrading Helix ALM
Perform the following tasks to upgrade Helix ALM. If you need help, contact Perforce Support.

Tip: Youmay want to install the new Helix ALM version in a test environment before upgrading your
production environment to evaluate new features, estimate downtime required to upgrade, andmake sure
no issues occur during the upgrade. See Installing Upgrades in a Test Environment.

Preparing for the upgrade
1. Review the release notes for information about new features, enhancements, bug fixes, and important

upgrade information.

2. Check the system requirements tomake sure computers you are installing Helix ALM components on
have the required space, memory, and other resources to run efficiently.

n Client system requirements

n License server system requirements

n Supported web browsers

n Server system requirements

n RDBMS support

3. If you are upgrading from TestTrack 2011.1 or earlier, review additional steps required to prepare
databases for upgrading.

4. If you currently use TestTrack 2013 or earlier and the web client, review important information about
upgrading to the Helix ALMWeb application.

5. Download the installer for the current Helix ALM version.

Performing the upgrade

The time is takes to upgrade depends on the components you are installing and your data.

Note: If you are upgrading both Helix ALM and Surround SCM, upgrade the product with themost recent
release date last to guarantee you install the latest version of the Helix ALM License Server.

1. Stop the Helix ALM License Server and Helix ALM Server.

2. Back up your license server database and Helix ALM databases and projects.

3. Run the Helix ALM installer. Youmay be prompted to overwrite existing files, such as SOAP or HTML
files. Always overwrite these files to ensure that Helix ALM works correctly after the upgrade.

4. Start the license server and Helix ALM Server applications. The server databases are automatically
upgraded when the servers start.

5. Upgrade projects if needed. Helix ALM can automatically upgrade projects when the server starts or you
canmanually upgrade them. See Upgrading projects, page 4.

After upgrading

Youmay need to perform the following tasks after upgrading.

n If you upgraded the 32-bit Helix ALM Server to the 64-bit server application onWindows, youmay need to
move the TTServDb directory from the 32-bit application directory to the 64-bit directory after upgrading.
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Upgrading projects

By default, the 32-bit application directory is in C:\Program Files (x86)\Perforce\Helix ALM and the 64-bit
directory is stored in C:\Program Files\Perforce\Helix ALM.

n If users cannot log in after upgrading, make sure a license is assigned to the user and that maintenance for
the license is not expired. See Users Cannot Log In After Upgrading.

Upgrading projects
After upgrading, Helix ALM can automatically upgrade projects when the server starts or you canmanually
upgrade them.

Note: Youmust manually upgrade projects if you use the Linux command line (Perl) installer.

Automatic upgrades

When the Helix ALM Server starts, you are prompted to automatically upgrade projects. Helix ALM native
projects are upgraded individually. Other projects in the same database, including inactive projects, are all
upgraded at the same time. After projects are upgraded, they are automatically loaded and available to users.
Errors are logged if upgrades fail.

Keep the following inmind:

n Projects are upgraded in the order they are displayed in the Projects list in the Helix ALM Server Admin
Utility. If you have a large number of projects, you can reorder them before upgrading tomake sure the
most frequently used projects are upgraded first. To reorder projects, in the server admin utility, choose
View > Projects. Select a project and click Top, Move Up, Move Down, or Bottom tomove it.

n Existing Helix ALM users with usernames and valid, non-expired licenses are automatically migrated as
global users to the Helix ALM License Server. Users without usernames are converted as local users.

Manual upgrades

Youmay want to manually upgrade projects using the Helix ALM Server Admin Utility if:

n You have a large number of projects and do not want to upgrade all of them at once.

n You are going to upgrade legacy Helix ALM 2011.1 or earlier native projects or convert them to a different
RDBMS format. These older project versions are not supported in Helix ALM. Youmust upgrade them to
TestTrack 2015.1 first. See Preparing to upgrade from TestTrack 2011.1 and earlier, page 4.

n Youwant to manually resolve user conflicts. If you use Helix ALM and Surround SCM, and users are set
up differently, theremay be conflicts caused by data differences on the servers. Manually upgrading
projects gives youmore control over conflict resolution. For example, users were configured using full
names (e.g., Deborah) in Surround SCM and using nicknames (e.g., Debbie) in Helix ALM. When you
manually upgrade, you can select the name to use.

Preparing to upgrade from TestTrack 2011.1 and earlier
You cannot use or upgrade older database versions in Helix ALM 2017.1 and later or TestTrack 2016 -
2016.1. To upgrade the TestTrack Server 2011.1 or earlier, youmust upgrade databases to TestTrack 2015.1
first. Contact Perforce Support for help with these upgrades.

Note: TestTrack was renamedHelix ALM starting with the 2017.1 release.
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Preparing to upgrade from TestTrack 2011.1 and earlier

Review the following steps required for this part of the upgrade process. The steps you follow depend on the
database type.

If you use: And you
want to:

Perform these steps to upgrade databases

Native
databases

Continue
using native
databases

1. Review information about upgrading native databases to SQLite format.

2. Install 32-bit TestTrack 2015.1.

3. Start the Seapine License Server and TestTrack Server. The TestTrack
Server database is automatically upgraded when the server starts.

4. Use the TestTrack Server Admin Utility to upgrade legacy native
projects to SQLite. Make sure to upgrade all projects youmay want to
use later, including archived or inactive projects, so they can be
upgraded for use in Helix ALM.

5. If you use external custom reports, configure them to use a SQLite
ODBC driver.

Convert
databases
to a
different
RDBMS

1. Create an empty RDBMS server database.

2. Install 32-bit TestTrack 2015.1.

3. Start the Seapine License Server and TestTrack Server. The TestTrack
Server database is automatically upgraded when the server starts.

4. Use the TestTrack Server Admin Utility to convert the server database
and legacy native projects to RDBMS. Make sure to upgrade all
projects youmay want to use later, including archived or inactive
projects, so they can be upgraded for use in Helix ALM.

RDBMS
databases
(Oracle,
PostgreSQL,
or
SQL Server)

Continue
using the
same
RDBMS

1. Install TestTrack 2015.1 (32-bit or 64-bit).

2. Start the Seapine License Server and TestTrack Server. The TestTrack
Server database is automatically upgraded when the server starts.

3. Use the TestTrack Server Admin Utility to upgrade legacy RDBMS
projects (version 11.0tt or earlier). Make sure to upgrade all projects you
may want to use later, including archived or inactive projects, so they
can be upgraded for use in Helix ALM.

Convert
databases
to native
SQLite or a
different
RDBMS

1. Create an empty RDBMS server database. Not required for SQLite.

2. Install TestTrack 2015.1 (32-bit or 64-bit).

3. Start the Seapine License Server and TestTrack Server. The TestTrack
Server database is automatically upgraded when the server starts.

4. Use the TestTrack Server Admin Utility to convert the server database
and legacy RDBMS projects (version 11.0tt or earlier) to Helix ALM
Native or another RDBMS format. Make sure to upgrade all projects you
may want to use later, including archived or inactive projects, so they
can be upgraded for use in Helix ALM.
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About automatic client upgrade installers

About automatic client upgrade installers
Helix ALM includes client installer packages that are used for automatic client upgrades. These packages are
installed with the Helix ALM Server to make cross-platform client deployment easier after server upgrades.
When users try to connect to the server with an older client version, they are notified to upgrade the client to
the newer version.

TheWindows, Mac, and Linux automatic client upgrade installer packages are installed in the installers
folders in the default Helix ALM directory.

Note: You can enable and disable automatic client upgrades in the Helix ALM Server Admin Utility. See
the Server Admin Utility help for information.
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Before You Install
Before installing Helix ALM, review the installation types to determine the options to select during the
installation. See Installation types, page 11.

Note: If you are installing on a 64-bit operating system, determine if you need to install 32-bit or 64-bit
components. See About 64-bit Helix ALM components, page 8.

Users

Keep the following inmind before installing the Helix ALM Client and other components.

n Review the Client System Requirements tomake sure the computer you are installing on has the required
space, memory, and other resources to run efficiently.

n If Microsoft Outlook is installed on your computer, close Outlook before installing the integration add-in.

Administrators

Keep the following inmind before installing and configuring Helix ALM server applications.

n If you use Surround SCM, the Helix ALM License Server and admin utility may already be installed on your
network. Check with the Surround SCM administrator.

n Review the Client System Requirements and the Server System Requirements tomake sure the
computers you are installing on have the required space, memory, and other resources to run efficiently.

n Determine which database type to store data in. You can use native SQLite databases or a different
RDBMS format. See About Helix ALM databases, page 7.

About Helix ALM databases
Helix ALM data is stored in Relational DatabaseManagement Systems (RDBMS). By default, Helix ALM
uses SQLite as the native backend database, which does not require any additional configuration before or
after installation. Oracle, PostgreSQL, and SQL Server are also supported, but a qualified database
administrator (DBA)must manually install and configure these databases.

The following data is stored in databases. Each component must be stored in a separate database. For
example, server data and projects cannot be stored in the same database.

n Helix ALM Server—Each server has a server database, which stores configuration information.

n Helix ALM projects—Project databases contain all project information, including items (e.g., issues,
requirements, test cases), local customers and users, filters, test configurations, security groups, and
reports. If you use native database format, each project is automatically stored in its own database. If you
use another RDBMS, you can storemultiple projects in the same database or distribute projects between
different RDBMS databases.

n Helix ALM License Server—Each license server has a database, which stores all license server data. See
the License Server help for information.
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About 64-bit Helix ALM components

When installing the Helix ALM Server, a SQLite server database file (ttserv.db) is created in the TTServerDb
directory in the Helix ALM application directory. After installation, you can use this server database as is or
use the server admin utility to convert it to a different RDBMS type, such as SQL Server. You can also store
new projects in other RDBMS databases or convert existing native project databases to a different RDBMS
type. Youmust create empty databases and add RDBMS connections before storing data in them. See
Setting UpRDBMS Databases, page 39.

Tip: For information about the differences between native and other RDBMS database formats, see
Choosing a Helix ALM Database Format .

About 64-bit Helix ALM components
32-bit and 64-bit versions of the Helix ALM Client and Server are available. The 64-bit server lets the server
computer access more RAM, which increases the size and number of projects it can store. The 64-bit client
lets users integrate with 64-bit third-party applications and use Helix ALM on 64-bit Linux systems without
needing to install additional libraries.

Keep the following inmind:

n The 32-bit clients can communicate with the 64-bit server and vice versa.

n All installers include the 32-bit and 64-bit components. If you run an installer on a 64-bit system, you can
select to install the 32-bit or 64-bit components. See Components installed on 64-bit systems, page 8.

n If you work with source control files from Helix ALM, youmay need to install the 32-bit or 64-bit client
depending on the version of the source control tool you use. See Setting Helix ALM configuration options,
page 14.

Components installed on 64-bit systems

If you are installing Helix ALM on a 64-bit operating system, you can choose to install 32-bit or 64-bit
components. The following information describes the available versions and what is installed based on the
computer configuration.

Windows

Component Installed as:

Defect Scribe 32-bit executable on 32-bit systems
32-bit and 64-bit executables on 64-bit systems

Microsoft Outlook Add-in 32-bit executable if 32-bit Microsoft Outlook is installed on
system
64-bit executable if 64-bit Microsoft Outlook is installed on
system

QAWizard Pro Add-in 32-bit executable only

Helix ALM License Server 32-bit or 64-bit executable depending on selected installation
option
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About 64-bit Helix ALM components

Component Installed as:

Helix ALM License Server Admin Utility 32-bit or 64-bit executable depending on selected installation
option

Helix ALM License Server Web Admin
Utility

32-bit or 64-bit executable depending on selected installation
option

SoloBug 32-bit executable only

Helix ALM Client 32-bit or 64-bit executable depending on selected installation
option

Helix ALM External Source
Control Provider CGI

32-bit executable only

Helix ALM Integration Library 32-bit executable on 32-bit systems
32-bit and 64-bit executables on 64-bit systems

Helix ALM Published Data Server CGI 32-bit executable only

Helix ALM Registry Utility 32-bit or 64-bit executable depending on selected installation
option

Helix ALM Server 32-bit or 64-bit executable depending on selected installation
option

Helix ALM Server Admin Utility 32-bit or 64-bit executable depending on selected installation
option

Helix ALM SOAP CGI 32-bit executable only

Helix ALM URL Redirector 32-bit executable only

Helix ALM Web CGI 32-bit executable only

Helix ALM Web Server Admin CGI 32-bit executable only

Visual Studio Add-in 32-bit executable only

Linux

Component Installed as:

Helix ALM License Server 32-bit or 64-bit executable depending on selected installation
option

Helix ALM License Server Admin Utility 32-bit or 64-bit executable depending on selected installation
option
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Installers

Component Installed as:

Helix ALM License Server Web
Admin Utility

32-bit or 64-bit executable depending on selected installation
option

SoloBug 32-bit executable only

Helix ALM Client 32-bit or 64-bit executable depending on selected installation
option

Helix ALM External Source
Control Provider CGI

32-bit executable only

Helix ALM Integration Library 32-bit executable on 32-bit systems
32-bit and 64-bit executables on 64-bit systems

Helix ALM Published Data Server CGI 32-bit executable only

Helix ALM Registry Utility 32-bit or 64-bit executable depending on selected installation
option

Helix ALM Server 32-bit or 64-bit executable depending on selected installation
option

Helix ALM Server Admin Utility 32-bit or 64-bit executable depending on selected installation
option

Helix ALM SOAP CGI 32-bit executable only

Helix ALM URL Redirector 32-bit executable only

Helix ALM Web CGI 32-bit executable only

Helix ALM Web Server Admin CGI 32-bit executable only

Mac

Component Installed as:

SoloBug 32-bit executable only

Helix ALM Client Fat binary that includes 32-bit and 64-bit executables

Helix ALM Integration Library Fat binary that includes 32-bit and 64-bit executables

Helix ALM Server Admin Utility Fat binary that includes 32-bit and 64-bit executables

Installers
Installers are available on the Upgrades page.
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Installation types

When you install Helix ALM, all issue, requirements, and test casemanagement features are installed. User
access to each area is controlled by licenses. For example, if a user does not have a valid issuemanagement
license, they cannot work with issues. Each Helix ALM license also includes a license for the SOAP-based
SDK.

Note: All installers includes 32-bit and 64-bit components. See About 64-bit Helix ALM components, page
8.

Platform Installation type Name

Windows Client and server ttwininstall.exe

Client only ttwinclientinstall.exe

Mac Client only ttmacclientinstall.dmg.gz

Linux Client and server (Java installer) ttlinuxjavainstall.tar.gz

Client and server (Perl command line installer) ttlinuxinstall.tar.gz

Client only ttlinuxclientinstall.tar.gz

Note: Java 1.5 or later is required to use the Linux Java installer. Use the Perl command line installer if
you do not have Java 1.5 or later.

Installation types
You can choose one of the following installation sets or specific components to install.

Install set Installs Notes

Typical
Install

Helix ALM Server, Helix ALM Client, Helix ALM Server Admin
Utility, SoloBug, Helix ALMWeb, Helix ALMWeb Server
Admin Utility, SoloSubmit, Helix ALM Source Control Provider
CGI, Helix ALM Published Data Server (CGI), Helix ALM
License Server, Helix ALM License Server Admin Utility, Helix
ALM License ServerWeb Admin Utility, and sample projects

A web server must be
installed on the computer
before installation. See
Configuring Helix ALM
Web, page 31.

Helix ALM
Client

Helix ALM Client and SoloBug Most users only need to
install the client.

Helix ALM
Server

Helix ALM Server, Helix ALM Client, Helix ALM Server Admin
Utility, SoloBug, Helix ALM License Server, Helix ALM License
Server Admin Utility, and sample projects

The server application is
generally installed on a
networked computer.
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Installation types

Install set Installs Notes

Helix ALM
Web
components

Helix ALMWeb, Helix ALMWeb Server Admin Utility, Helix
ALM Source Control Provider CGI, Helix ALM Published Data
Server (CGI), Helix ALM SOAP CGI, and SoloSubmit

A web server must be
installed on the computer
before installation. See
Configuring Helix ALM
Web, page 31.

Helix ALM
License
Server

Helix ALM License Server, Helix ALM License Server Admin
Utility, and Helix ALM License ServerWeb Admin Utility

A web server must be
installed on the computer
before installation if you
are also installing the
web admin utility. See
Configuring Helix ALM
Web, page 31.

Custom Components you select
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Running the Installer
After downloading the installer, run it on the computer to install Helix ALM components on.

Note: To install 64-bit applications, youmust run the installer on a 64-bit system.

Windows
Double-click the installation file.

Tip: You can run aWindows client-only installation in silent mode from the command prompt using the -i
silent option. The network administrator can deploy a silent install to multiple computers without user
intervention. The Helix ALM Client and SoloBug are installed in the default location using the default
options. SeeWindows Silent Installation for information.

Linux

Note: Specific system libraries are required to run Helix ALM and Helix ALM License Server applications
on different Linux distributions. Youmust install these libraries before using the applications tomake sure
they work correctly. See Checking for Missing System Libraries on Linux for information.

Java installer

1. Double-click the installer archive or enter tar -zxvf <InstallerFilename>.tar.gz in Terminal to
extract the installer.

2. Run the extracted .bin file as root to start the installer.

Perl command line installer

1. In Terminal, enter tar -zxvf <InstallerFilename>.tar.gz to extract the installer.

2. Enter cd tt-<version> to change to the Helix ALM application directory. For example, if you are
installing Helix ALM 2017.1.1, enter cd tt-2017.1.1.

3. Enter./install.pl as root to run the install script.

Mac

1. Double-click the installation file to extract the installer and then double-click ttmacclientinstall.dmg to
mount the image on the desktop.

2. Double-click the Helix ALM disk image and then double-click the Install Helix ALM icon.

During installation

Youmust select settings for the components you choose to install. Depending on the installation type, you
may be prompted to select options for the following components:

n Helix ALM applications

n Third-party integrations
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Setting Helix ALM configuration options

n Helix ALM CGIs

n Helix ALM SOAP Server

n Short date format (Linux only)

n Helix ALM License Server

Setting Helix ALM configuration options

Note: If installing Helix ALM on a 64-bit system, you can choose to install 32-bit or 64-bit versions of the
selected applications. See About 64-bit Helix ALM components, page 8. If you integrate with a source
control application, youmay need tomake sure the correct version of Helix ALM (32- or 64-bit) is installed
for the integration to work. See the Integrations knowledgebase for integration requirements.

Youmust select a Helix ALM application directory. The Linux installers also require you to select a directory
for creating the Startup.log file, which contains errors that are logged when the Helix ALM Server starts. You
can use the default directory or select a different directory.

Additional configuration options include setting the server port number and choosing a server executionmode
(Windows only).

Default installation directories

Installer Files Default directory

Windows 32-bit applications (all files) C:\Program Files
(x86)\Perforce\Helix ALM

64-bit applications (all files) C:\Program
Files\Perforce\Helix ALM

Mac Client executable programs, lexicons, and other supporting
files

/Applications/HelixALM

Linux Client executable programs, server database, stylesheets,
lexicons, and other supporting files

/var/lib/HelixALM

Startup.log file /var/log

Other executable programs, shell scripts, and Helix ALM
Server daemon

/usr/bin

Server execution mode (Windows)

You can choose to run the Helix ALM Server as a service to automatically start the server when the computer
starts. Youmust configure the service to log in as the Local System Account.

If you run the server as an application, youmust manually start the server application.
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Selecting integration options

Server port

The Helix ALM Server communicates with clients on this port. Use the default port number or enter another
number.

Platform Default port

Windows 99

Linux 1566

Selecting integration options
Options are available to integrate Helix ALM with Microsoft Visual Studio, Microsoft Outlook, and Defect
Scribe.

Visual Studio

If Microsoft Visual Studio is installed on your computer, select Install Visual Studio Integration to add the
Helix ALMmenu and toolbar to Visual Studio to access items and actions. See Visual Studio Integration for
information.

Outlook

If Microsoft Outlook is installed on your computer, select Install Helix ALM Outlook Add-in to add issues,
requirements, or test cases from emails or add emails to existing items. SeeMicrosoft Outlook Integration for
information.

Note: CloseOutlook before installing Helix ALM.

Defect Scribe (Windows only)

Defect Scribe can help you capture information whenmanually testing applications and seamlessly create
new issues or test cases from the test results. If Defect Scribe is not installed on your computer, select
Install Defect Scribe to automatically run the installer after Helix ALM installation is complete. See the
Defect Scribe help for information.

Setting CGI configuration options
If you are installing the Helix ALM CGIs, youmust select a location to install the CGI scripts and HTML files
and set the Helix ALM Server address and port number. When web client users log in, or an external source
control provider attaches files to items in a project, the web server calls the appropriate CGI, which
communicates with the Helix ALM Server.

Note:We strongly recommend configuring HTTPS for the CGIs on the web server. Login credentials sent
from web clients to the CGIs are not encrypted, even if encryption is enabled on the server. See your web
server documentation for information about configuring and using HTTPS.
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Setting CGI configuration options

Web server types

Microsoft IIS and Apache web servers are supported. See SupportedWeb Servers for supported versions.

Default HTML file installation directories

Select the directory to install the HTML files used by Helix ALM web clients.

Note: If you are upgrading, youmay be prompted to overwrite existing HTML files during installation. You
should always overwrite these files to ensure that Helix ALM works correctly after the upgrade is
complete.

Web server Platform Default HTML files directory

IIS Windows C:\inetpub\wwwroot

Apache Windows C:\Program Files\Apache Software Foundation\Apache <version>\htdocs

Linux /var/www/html

Helix ALM Server address and port

Enter a static IP address or domain name and port number of the Helix ALM Server computer. The Helix ALM
CGIs use this information to communicate with the server. You are only prompted to enter this information the
first time you install Helix ALM.

Platform Default server port

Windows 99

Linux 1566

Note: If CGIs are installed on Linux distributions with SELinux security policies, youmust enable network
requests from CGI executables before you can use Helix ALM web clients. See CGIs on Linux Cannot
Connect to the Helix ALM License Server and Helix ALM Server for information.

Default CGI installation directories

Select the directory to install the CGI scripts. The web server must have access to this directory.

Web
server

Platform Default logical CGI
directory name

Default CGI scripts directory

IIS Windows scripts C:\inetpub\scripts

Apache Windows cgi-bin C:\Program Files\Apache Software
Foundation\Apache <version>\cgi-bin

Linux cgi-bin /var/www/cgi-bin
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Setting SOAP server configuration options

Note: If you are installing the Helix ALM License ServerWeb Admin Utility, youmust set a location to
install the CGI scripts and HTML files. See Setting Helix ALM License Server configuration options, page
17.

Setting SOAP server configuration options
Enter the IP address or domain name of the computer that is hosting the SOAP CGI and the port number. The
default port is 80.

Note: See the SDK help for information about using the SOAP-based SDK.

Setting the short date format on Linux
On Linux, you can set the short date format used for reports, email notifications, and the startup log file, and
any other date string created by the Helix ALM Server.

Valid date formats include: %m/%d/%y, %d/%m/%y, %b/%d/%y, or%d/%b/%y. You can substitute%bwith
%B or%y with%Y in these formats. The year parameter must be last in the date format.

Valid delimiters include a period, dash, forward slash, backward slash, comma, or a space.

Character Description Example

%b Abbreviatedmonth name Mar

%B Full month name March

%d Day of themonth, 01-31 22

%m Month of the year, 01-12 03

%y Two-digit year 99

%Y Four-digit year 1999

Setting Helix ALM License Server configuration options
Youmust select a Helix ALM License Server application directory. The Linux installers also require you to
select a directory for creating the LSStartup.log file, which contains errors that are logged when the server
starts. You can use the default directory for these options or select a different directory.

Additional configuration options include setting the server port number, choosing a server executionmode
(Windows only), and setting the web server admin utility CGI and HTML file locations.

Default installation directories

Platform Files installed Default directory

Windows All files C:\Program
Files\Perforce\License Server
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Setting Helix ALM License Server configuration options

Platform Files installed Default directory

Linux Application /var/lib/splicsvr

LSStartup/log file /var/log

Other executable Unix programs, shell scripts, and the
license server daemon

/usr/bin

Web server admin utility CGI and HTML file installation directories

If you are installing the license server web admin utility, youmust set a location to install the CGI scripts and
HTML files.

Microsoft IIS and Apache web servers are supported. See SupportedWeb Servers for supported versions.

Web
server

Platform Default CGI directory Default HTML files directory

IIS Windows C:\inetpub\scripts C:\inetpub\wwwroot

Apache Windows C:\Program Files\Apache Software
Foundation\Apache <version>\cgi-bin

C:\Program Files\Apache Software
Foundation\Apache <version>\htdocs

Linux /var/www/cgi-bin /var/www/html

Note: If CGIs are installed on Linux distributions with SELinux security policies, youmust enable network
requests from CGI executables before you can use Helix ALM web clients. See CGIs on Linux Cannot
Connect to the Helix ALM License Server and Helix ALM Server for information.

Server execution mode (Windows only)

You can choose to run the license server as a service to automatically start the server when the computer
starts. If you run the server as an application, youmust manually start it.

Server port

Helix ALM clients and the license server web admin utility CGIs communicate with the license server on this
port. Use the default port number (5100) or enter another number.
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Starting Helix ALM
The Helix ALM License Server and Helix ALM Server must be running before you start Helix ALM. Contact
your administrator for help if the servers are not running. See Starting the Helix ALM License Server, page 21
and Starting the Helix ALM Server, page 29.

Helix ALM Client

Before you log in, make sure you have the Helix ALM Server and login information from your Helix ALM
administrator.

1. Windows—ChoosePrograms > Perforce > Helix ALM > Helix ALM Client on the Start menu.

Mac—Double-click theHelix ALM Client icon in the Applications/HelixALM folder.

Linux—Enter /usr/bin/ttclient

2. When the application starts, select theServer to connect to. If you need to set up a server connection,
see the Helix ALM help for information about adding server connections.

3. Enter yourUsername andPassword.

If available, you can select Use single sign-on to log in with your network credentials orUse external
authentication to log in with your authentication system credentials. Ask your administrator for help.

4. Click Connect.

5. Select aProject and areas to log in to.

6. Click OK.

You are logged in and ready to start using Helix ALM. See the Helix ALM help for more information.

Note: If you cannot log in because the required public key is not found, youmay need to import a server
settings XML file provided by your administrator. The public key is used for stronger security when
communicating with the server. See Configuring a Helix ALM Server connection, page 30. If you do not
have the file or continue to experience login problems, contact your administrator for help.

Helix ALM Web

To use Helix ALM Web, you need the Helix ALM URL and your username and password.

1. Start a web browser and enter the URL.

The URL uses the server name or IP address of the web server hosting Helix ALM and the path to the
login page. For example, http://www.yourserver.com/ttweb.

2. Enter yourUsername andPassword.

If available, you can select Use single sign-on to log in with your network credentials orUse external
authentication to log in with your authentication system credentials. Ask your administrator for help.

3. Click Log In.

4. Select aProject and areas to log in to.

5. Click Connect.

You are logged in and ready to start using Helix ALM. See the Helix ALMWeb help for more information.
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Configuring the Helix ALM License Server
The Helix ALM License Server must be running and configured before users can access Helix ALM.

1. Make sure the Helix ALM License Server is running.

2. Start the Helix ALM License Server Admin Utility and configure a license server connection.

Note: To use the Helix ALM License Server Web Admin Utility, youmust install and configure the
license server web components. See Configuring web servers for the Helix ALM License ServerWeb
Admin Utility, page 23.

3. Add licenses and users to the license server.

Starting the Helix ALM License Server
An administrative user must make sure the Helix ALM License Server is running before the Helix ALM Server
is started.

Tip: If Helix ALM cannot connect to the license server, an administrative user needs to troubleshoot. See
Helix ALM Cannot Connect to the License Server for information.

Windows

If the license server is installed as a service, it starts automatically. If the license server is installed as an
application, youmust start it manually. ChooseAll Programs > Perforce > Helix ALM License Server
> Helix ALM License Server from the Start menu.

Note: If the server is installed as a service but not running or you need to restart it, see theWindows
documentation for information about starting a service.

Linux

Enter /usr/bin/spls start.

If you need to restart the server, enter /usr/bin/spls stop and then restart the server.

Starting Helix ALM License Server Admin Utility
Use the Helix ALM License Server Admin Utility to manage Helix ALM product licenses and global users and
customers.

Windows

ChooseAll Programs > Perforce > Helix ALM License Server > Helix ALM License Server Admin on
the Start menu.

Linux

Enter /usr/bin/lsadmin.
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Configuring a Helix ALM License Server connection

Web

In a web browser, enter the server admin utility URL. The URL uses the static or IP address of the web server
hosting the admin utility and the path to the admin utility files. For example,
http://www.yourserver.com/lsweb/admin.

Configuring a Helix ALM License Server connection
The Helix ALM Server connects to the Helix ALM License Server to authenticate license and user information.

If you installed the Helix ALM Server and the Helix ALM License Server on the same computer and chose to
use the default port numbers (5100 for license server and 99 onWindows or 1566 on Linux for the Helix
ALM Server), the Helix ALM Server automatically connects to the license server when it starts.

Tip: If the license server is installed on a different computer or port, or is not found, you can log in using
the local admin password to verify the connection information. See Troubleshooting, page 45 for
information.

1. Start the Helix ALM License Server and the Helix ALM License Server Admin Utility.

2. Click Setup on the Helix ALM License Server Login dialog box.

3. Click Add on the Setup Server Connections dialog box.

4. Enter aServer Name, Server Address, andPort. The default port is 5100.

5. Click OK to add the server connection.

6. Click Close in the Setup Server Connections dialog box to return to the Helix ALM License Server Login
dialog box.

7. Log in as the default administrative user and click Connect. The username is Administrator and there is
no password.

By default, the Administrator user has full admin security permissions and uses a floating license. We
strongly recommend setting a password for this user to prevent unauthorized user access.

Adding licenses to the Helix ALM License Server
Users must have a license to access Helix ALM. Helix ALM product licenses aremanaged in the Helix ALM
License Server. When you purchase a license, you need to add it to the license server before assigning it to
users.

Note: If you need to purchase Helix ALM or other product licenses, contact Perforce Sales.

1. Start the Helix ALM License Server Admin Utility.

2. Click Licenses.

The Helix ALM Licenses dialog box opens.

3. Click Add.

The Add License dialog box opens.

4. Enter the serial number or click Browse to select a license file.
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Adding users to the Helix ALM License Server

License files have a .lic extension. If youmanually enter a license, the Serial Number field is case
sensitive. Licenses can be entered with or without dashes.

5. Click OK to add the license.

You can assign the license to users to provide access to Helix ALM. See Adding users to the Helix ALM
License Server, page 23.

Adding users to the Helix ALM License Server
Add users to the license server to provide access to Helix ALM. Users added to the license server are global
users and can be shared across Helix ALM products.

Tip: You can also add global users and local users who only need Helix ALM access directly in Helix
ALM. See the Helix ALM help for information.

1. Start the Helix ALM License Server Admin Utility.

2. Click Global Users.

TheGlobal Users dialog box opens.

3. Click Add and then select Add User.

The Add User dialog box opens.

4. Enter the user's contact information, username and password, security permissions, and licenses. See
the Helix ALM License Server help for information.

5. Click Add to add the user to the Global Users list.

6. Close the Helix ALM License Server Admin Utility.

You are prompted to change the communications and Administrator passwords. We strongly recommend
changing these passwords to prevent unauthorized user access.

After global users are added to the license server, you can retrieve them in Helix ALM and then add them
to security groups. See the Helix ALM help for information.

Configuring web servers for the Helix ALM License Server Web
Admin Utility
The Helix ALM License ServerWeb Admin Utility requires a set of HTML files and CGI scripts, which are
hosted and configured on a web server. See Helix ALM License Server SupportedWeb Servers for a list of
supported web servers. The utility components can be installed during Helix ALM installation.

After installation, you need to configure the web server before administrative users can use the utility. See the
following information to configure your web server.

n Apache

n IIS 7 and later

n IIS 6

Security notes

n Login credentials sent from the Helix ALM License ServerWeb Admin Utility to the CGI are not encrypted,
even if encryption is enabled on the server. We strongly recommend configuring HTTPS to encrypt
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Configuring Apache for the Helix ALM License Server Web Admin Utility

communication from the browser to the CGI on the web server. See your web server documentation for
information about configuring and using HTTPS.

n Clickjacking can occur when hackers use transparent frames or iframes to embed content in web pages to
trick users into click buttons or hyperlinks on a different web page in another domain or application. To
protect your data and prevent clickjacking in Helix ALMWeb and the license server web admin utility,
configure the web server that hosts them to include X-Frame-Options and Content-Security-Policy
HTTP response headers. See Preventing Clickjacking Attempts in Helix ALM WebClients for information.

Configuring Apache for the Helix ALM License Server Web
Admin Utility
After you install the Helix ALM License ServerWeb Admin Utility files, you need to create a CGI directory
alias on the Apache web server before administrative users can log in.

1. Open the httpd.conf file in the Apache application directory.

2. Search the file for ScriptAlias /cgi-bin on a line that does not start with a pound symbol (#).

If the directory does not exist, add the following line to the file to point to the location where CGIs are
installed:
ScriptAlias /cgi-bin/ "<Apache application directory path>/cgi-bin/"

Windows example

The Apache application directory location varies based on Apache andWindows versions. Replace <Apache
application directory path> with the exact directories in the cgi-bin path. Following are examples of the default
paths. Apache accepts forward or back slashes inWindows paths.

Windows version 32-bit Apache path 64-bit Apache path

64-bit C:\Program Files (x86)\Apache C:\Program Files\Apache

32-bit C:\Program Files\Apache --

Example:
ScriptAlias /cgi-bin/ "C:\Program Files\Apache Group\Apache\cgi-bin\"

Linux example
ScriptAlias /cgi-bin/ "/var/www/cgi-bin/"

Configuring Microsoft IIS 7 and later for the Helix ALM License
Server Web Admin Utility
After you install the Helix ALM License ServerWeb Admin Utility files, you need to configure the web server
before administrative users can log in.

See License Server SupportedWeb Servers for information about supportedMicrosoft Internet
Information Server (IIS) versions. Refer to the IIS documentation for information about enabling CGI
execution and authentication.
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Configuring Microsoft IIS 7 and later for the Helix ALM License Server Web Admin Utility

Note: If you use IIS 6, see ConfiguringMicrosoft IIS 6 for the Helix ALM License ServerWeb Admin
Utility, page 26.

Enabling support for CGI executables

Windows Vista, 7, 8, 8.1, and 10

1. ChooseStart > Control Panel > Programs and Features.

2. Click Turn Windows features on or off in the Tasks pane.

3. Expand the Internet Information Services,World Wide Web Services, andApplication
Development Features nodes.

4. Select CGI.

5. Click OK to save the changes.

Windows Server 2008

1. Choose Start > Control Panel > Programs and Features.

2. Click Turn Windows features on or off in the Tasks pane.

3. Click Roles in the left pane.

4. Click Add Role Services in the right pane.

5. Expand theWeb Server andApplication Development Features nodes.

6. Select CGI.

7. Click OK to save the changes.

Windows Server 2012

1. Choose Start > Control Panel > Programs and Features.

2. Click Turn Windows features on or off in the Tasks pane.

3. Select Role-based or feature-based installation on the Installation Type page and click Next.

4. Select the server you want to use and click Next.

5. Expand theWeb Server (IIS),Web Server, andApplication Development Features nodes.

6. Select CGI and click Next.

7. Click Next to skip the Features information. You do not need to change any of these values.

8. Click Install to save the changes.

Creating a CGI directory alias

Note: If you are configuring IIS for the Helix ALM License Server Web Admin Utility and Helix ALM Web,
and the CGIs for both applications are in the same directory (e.g., C:\inetpub\scripts), you only need to
create one CGI directory alias.

1. Open IIS Manager.
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Configuring Microsoft IIS 6 for the Helix ALM License Server Web Admin Utility

2. In the Connections pane, expand the server computer and Sites nodes.

3. Right-click Default Web Site and chooseAdd Virtual Directory.

The Add Virtual Directory dialog box opens.

4. Enter 'scripts' as theAlias.

5. Enter the path to the lscgi.exe as thePhysical Path. This is the path entered during the admin utility
installation. The default path is C:\inetpub\scripts.

6. Click OK to save the changes.

Enabling the .exe CGI extension
1. Select the scripts virtual directory in the Connections pane.

2. Double-click Handler Mappings.

3. Click Add Module Mapping in the Actions pane.

The AddModuleMapping dialog box opens.

4. Enter 'lscgi.exe' as theRequest path.

5. Select CgiModule as theModule.

6. Enter 'lscgi' as theName.

7. Click OK to save the changes.

8. Select the server computer in the Connections pane.

9. Double-click ISAPI and CGI Restrictions.

10. Click Add in the Actions pane.

The Add ISAPI or CGI Restriction dialog box opens.

11. Enter the path to the lscgi.exe program as the ISAPI orCGI path. This is the path entered for the
lscgi.exe program during the admin utility installation. The default path is C:\inetpub\scripts\lscgi.exe.

12. Enter 'lscgi' as theDescription.

13. Select Allow extension path to execute.

14. Click OK to save the changes.

Configuring Microsoft IIS 6 for the Helix ALM License Server
Web Admin Utility
After you install the Helix ALM License ServerWeb Admin Utility files, you need to configure the web server
before administrative users can log in.

See License Server SupportedWeb Servers for information about supportedMicrosoft Internet
Information Server (IIS) versions. Refer to the IIS documentation for information about enabling CGI
execution and authentication.

Note: If you use IIS 7 or later, see ConfiguringMicrosoft IIS 7 and later for the Helix ALM License Server
Web Admin Utility, page 24.
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Configuring Microsoft IIS 6 for the Helix ALM License Server Web Admin Utility

Creating a CGI directory alias

Note: If you are configuring IIS for the Helix ALM License Server Web Admin Utility and Helix ALM Web,
and the CGIs for both applications are in the same directory (e.g., C:\inetpub\scripts), you only need to
create one CGI directory alias.

1. Open IIS Manager.

2. Expand the server computer andWeb Sites nodes.

3. Right-click Default Web Site and chooseNew > Virtual Directory.

The Virtual Directory Creation Wizard opens.

4. Follow the on-screen instructions. Enter the following information when prompted:

n Enter ‘scripts’ as theAlias.

n Set theDirectory to the path that was entered during the admin utility installation for the lscgi.exe
program. The default path is C:\inetpub\scripts.

n Select the followingAccess Permissions: Read, Run scripts, Execute.

5. Click Finish to save the changes.

Enabling the .exe CGI extension
1. In IIS Manager, expand the server computer and selectWeb Service Extensions.

2. Click Add a new Web service extension in theWeb Service Extensions pane.

3. Enter 'LSAdmin' as theExtension name.

4. Click Add.

5. Enter the path to the lscgi.exe program and click OK. The default location is C:\inetpub\scripts\lscgi.exe.

6. Select Set extension status to Allowed.

7. Click OK.

8. Click OK to save the changes.
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Configuring New Helix ALM Installations
Before users can access Helix ALM, the administrator needs to perform the following tasks.

1. Make sure the Helix ALM Server is running.

2. If you installed Helix ALM web components, configure the web server.

3. Start the Helix ALM Server Admin Utility and configure a server connection.

Note: During installation, an administrative user with full admin security permissions is created. To
log in as this user, enterAdministrator as the username and leave the Password field empty. If you
want to create a different admin user, you can delete this user. If you do not want to delete this user,
add a password to prevent unauthorized users from logging in to the admin account.

4. Create a project and configure server options.

5. After creating a project, perform the following tasks so users can work in it.

n Start the Helix ALM Client

n Retrieve users from the Helix ALM License Server

n Set up security groups

n Configure project options

Starting the Helix ALM Server
An administrative user must make sure the Helix ALM Server is running before users can access Helix ALM.

Tip: If users cannot connect to the Helix ALM Server when it is running, an administrative user needs to
make sure the server computer is online and the Helix ALM License Server is also running. Users should
make sure the IP address and port number are correct in the server connection information.

Windows

If the Helix ALM Server is installed as a service, it starts automatically. If the server is installed as an
application, youmust start it manually. ChooseAll Programs > Perforce > Helix ALM > Helix ALM
Server from the Start menu.

Note: If the server is installed as a service but not running or you need to restart it, see theWindows
documentation for information about starting a service.

Linux

Enter /usr/bin/ttstudio start.

If you need to restart the server, enter /usr/bin/ttstudio stop and then restart the server.

Starting the Helix ALM Server Admin Utility
The Helix ALM Server Admin Utility is used tomanage projects, the server log, server users, themail queue,
and server options.
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Configuring a Helix ALM Server connection

n Windows—ChoosePrograms > Perforce > Helix ALM > Helix ALM Server Admin on the Start
menu.

n Mac—Double-click theHelix ALM Server Admin Utility icon in the Applications/HelixALM folder.

n Linux—Enter /usr/bin/ttadmin

n Web—In aweb browser, enter the server admin utility URL. The URL uses the static or IP address of the
web server to connect to and the path to the admin utility login page. For example,
http://www.yourserver.com/ttweb/ttadmin/adminlogin.htm. If the login dialog box does not open
automatically, click Go To Login on theWelcome page.

Note: If RSA key exchange is enabled, youmay be prompted to verify the authenticity of the key
fingerprint, which is used to prevent hacking. Verify that you are logging in to the correct server. If you are
unsure if the fingerprint is correct, log in locally to server admin utility on the server computer and verify
that the key displayed in the Security server options matches the key displayed when you logged in from
the other computer. If the fingerprint is correct, click Yes to log in. If a different fingerprint is displayed, a
hack may be in progress.

Configuring a Helix ALM Server connection
You need to configure a Helix ALM Server connection and create at least one project before users can log in to
Helix ALM.

1. Start the Helix ALM Server and Helix ALM Server Admin Utility.

2. Click Setup on the login dialog box if the Setup Server Connections dialog box does not open
automatically.

3. Click Add to add a server connection.

4. Enter aServer Name, Server Address, andPort Number.

Note: If RSA key exchange is enabled for the server, click Import to import the server settings
instead of manually entering the information. Select the XML file and click Open. The Server
address, Port, and Public key fingerprint fields are automatically populated. The public key is required
to connect to the server. See the Server Admin Utility help for information.

5. Click OK to add the server connection.

6. Click Close in the Setup Server Connections dialog box to return to the login dialog box.

7. Log in as the default administrative user and click Connect. The username is Administrator and there is
no password.

8. Click Projects and create at least one project. See the Server Admin Utility help for information.

9. Close the server admin utility when you finish adding projects.

Note: Before users can access a project, youmust retrieve the users from the license server to the
project and add them to at least one security group using the Helix ALM Client. See the Helix ALM help for
information about retrieving users and adding them to security groups.

30

http://help.seapine.com/help.php?product=helixalm&type=admin&topic=ConfigureRSA
http://help.seapine.com/help.php?product=helixalm&type=admin&topic=CreateProjects
http://help.seapine.com/help.php?product=helixalm&type=client&topic=RetrieveGlobalUser
http://help.seapine.com/help.php?product=helixalm&type=client&topic=EditUser


Configuring Helix ALM Web
Helix ALM Web is a web-based client for accessing Helix ALM project data. The Helix ALM Web Server
Admin Utility is a web-based client for managing server configurations. You can use these clients in a
supported browser from any computer.

The web clients use a set of HTML files and CGI scripts, which are hosted and configured on a web server.

Administrator

The web components are installed during server or custom installations. After installation, you need to
configure the web server before users can log in using the web clients. See SupportedWeb Servers for a list
of supported web servers.

See the following information to configure your web server.

n Apache

n IIS 7 and later

n IIS 6

Security notes

n Login credentials sent from web clients to the CGIs are not encrypted, even if encryption is enabled on the
server. We strongly recommend configuring HTTPS to encrypt communication from the browser to the
CGIs on the web server. See your web server documentation for information about configuring and using
HTTPS.

n Clickjacking can occur when hackers use transparent frames or iframes to embed content in web pages to
trick users into click buttons or hyperlinks on a different web page in another domain or application. To
protect your data and prevent clickjacking in Helix ALMWeb and the license server web admin utility,
configure the web server that hosts them to include X-Frame-Options and Content-Security-Policy
HTTP response headers. See Preventing Clickjacking Attempts in Helix ALM WebClients for information.

User

To use Helix ALMWeb, you only need to enter the URL in a web browser. See Starting Helix ALM, page 19.

Youmay also need to install the Helix ALM URLRedirector to access ttstudio hyperlinks. See Installing the
Helix ALM URLRedirector, page 36.

About distributed Helix ALM web installations
You can install the Helix ALM Server on the same computer as the web server or another computer as long as
they are located in the same network. If you have a large Helix ALM installation, youmay want to host
multiple servers onmultiple computers running against one or more web servers. Regardless of the
configuration, when a user accesses the Helix ALM CGIs, the CGIs safely and securely communicate with
the server behind your firewall.

Distributed installations provide the following benefits:

n Enhanced security—Hosting the Helix ALM web components on one computer and data on another
computer provides more security. A hacker who accesses your web server will not have access to any
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Configuring Apache

data.

n Better performance—Separating the web server and the Helix ALM Server lets you split up the workload,
increasing the performance of both server computers. Usingmultiple Helix ALM Servers on different
computers can improve performance evenmore. In addition, SoloSubmit can be installed on up to 10
additional web servers, which allows customers to access separate SoloSubmit URLs while submitting
issues and requests to the same server or project.

n Greater flexibility—Web client users can log in to all Helix ALM Servers hosted by the web server
simultaneously. All projects the user has access to are displayed in the Projects list.

Perform the following steps to configure a distributed Helix ALM web installation:

1. Install the Helix ALM Server, Client, and Server Admin Utility on the computer that will host the server
application and projects.

2. Install the web and CGI components on the computer that will host the web components.

3. Configure the web server for Helix ALM.

4. To provide access tomultiple Helix ALM Servers from a single web server, configure the CGIs to connect
to the servers. See the Registry Utility help for information.

Configuring Apache
Youmust create a CGI directory alias on the Apache web server before users can log in to Helix ALM web
clients.

1. Open the httpd.conf file in the Apache application directory.

2. Search the file for ScriptAlias /cgi-bin on a line that does not start with a pound symbol (#).

If the directory does not exist, add the following line to the file to point to the location where CGIs are
installed:
ScriptAlias /cgi-bin/ "<Apache application directory path>/cgi-bin/"

Windows example

The Apache application directory location varies based on Apache andWindows versions. Replace <Apache
application directory path> with the exact directories in the cgi-bin path. Following are examples of the default
paths. Apache accepts forward or back slashes inWindows paths.

Windows version 32-bit Apache path 64-bit Apache path

64-bit C:\Program Files (x86)\Apache C:\Program Files\Apache

32-bit C:\Program Files\Apache --

Example:
ScriptAlias /cgi-bin/ "C:\Program Files\Apache Group\Apache\cgi-bin\"

Linux example
ScriptAlias /cgi-bin/ "/var/www/cgi-bin/"

Note: If you cannot log in to Helix ALM web clients, seeWebClients Return a 404-Page Not Found Error.
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Configuring Microsoft IIS 7 and later for Helix ALM Web

Configuring Microsoft IIS 7 and later for Helix ALM Web
After you install the Helix ALM web components, you need to configure the web server before users can log in
to web clients.

See SupportedWeb Servers for information about supportedMicrosoft Internet Information Server (IIS)
versions. Refer the IIS documentation for information about enabling CGI execution and authentication.

Note: If you use IIS 6, see ConfiguringMicrosoft IIS 6 for Helix ALMWeb, page 35.

Enabling support for CGI executables

Windows Vista, 7, 8, 8.1, and 10

1. ChooseStart > Control Panel > Programs and Features.

2. Click Turn Windows features on or off in the Tasks pane.

3. Expand the Internet Information Services,World Wide Web Services, andApplication
Development Features nodes.

4. Select CGI and ISAPI Extensions.

5. Click OK to save the changes.

Windows Server 2008

1. Choose Start > Control Panel > Programs and Features.

2. Click Turn Windows features on or off in the Tasks pane.

3. Click Roles in the left pane.

4. Click Add Role Services in the right pane.

5. Expand theWeb Server andApplication Development Features nodes.

6. Select CGI and ISAPI Extensions.

7. Click OK to save the changes.

Windows Server 2012

1. Choose Start > Control Panel > Programs and Features.

2. Click Turn Windows features on or off in the Tasks pane.

3. Select Role-based or feature-based installation on the Installation Type page and click Next.

4. Select the server to use and click Next.

5. Expand theWeb Server (IIS),Web Server, andApplication Development Features nodes.

6. Select CGI and click Next.

7. Click Next to skip the Features information. You do not need to change any of these values.

8. Click Install to save the changes.
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Configuring Microsoft IIS 7 and later for Helix ALM Web

Creating a CGI directory alias

Note: If you are configuring IIS for the Helix ALM License Server Web Admin Utility and Helix ALM Web,
and the CGIs for both applications are in the same directory (e.g., C:\inetpub\scripts), you only need to
create one CGI directory alias.

1. Open IIS Manager.

2. In the Connections pane, expand the server computer andSites nodes.

3. Right-click Default Web Site and chooseAdd Virtual Directory.

The Add Virtual Directory dialog box opens.

4. Enter 'scripts' as theAlias.

5. Enter the path to the ttcgi.exe as thePhysical Path. This is the path entered during the Helix ALM
installation. The default path is C:\inetpub\scripts.

6. Click OK to save the changes.

Enabling the .exe CGI extension
1. Select the scripts virtual directory in the Connections pane.

2. Double-click Handler Mappings.

3. Click Add Module Mapping in the Actions pane.

The AddModuleMapping dialog box opens.

4. Enter 'ttcgi.exe' as theRequest path.

5. Select CgiModule as theModule.

6. Enter 'ttcgi' as theName.

7. Click OK to save the changes.

8. Repeat steps 3-7 for other web clients you use.

n If you use the web server admin utility, add ttadmcgi.exe.

n If you use SOAP, add ttsoapcgi.exe.

n If you use an external source control provider, such as Git, add ttextpro.exe.

9. Select the server computer in the Connections pane.

10. Double-click ISAPI and CGI Restrictions.

11. Click Add in the Actions pane.

The Add ISAPI or CGI Restriction dialog box opens.

12. Enter the path to the ttcgi.exe program as the ISAPI orCGI path. This is the path entered for the ttcgi.exe
program during the Helix ALM installation. The default path is C:\inetpub\scripts\ttcgi.exe.

13. Enter 'ttcgi' as theDescription.

14. Select Allow extension path to execute.

15. Click OK to save the changes..

16. Repeat steps 11-15 for other web clients you use.

34



Configuring Microsoft IIS 6 for Helix ALM Web

n If you use the web server admin utility, add ttadmcgi.exe.

n If you use SOAP, add ttsoapcgi.exe.

n If you use an external source control provider, such as Git, add ttextpro.exe.

Changing the CGI response buffer limit
1. Select the scripts virtual directory in the Connections pane.

2. Double-click Configuration Editor.

3. In theSection list, expand system.WebServer and select handlers.

4. Select (Collection) and click Edit Items in the '(Collection)' Element pane.

The Collection Editor dialog box opens.

5. Select ttcgi.

6. Change the responseBufferLimit property value to 0.

7. If you use SOAP, select the ttsoapcgi item and change the responseBufferLimit property value to 0.

8. Close the Collection Editor dialog box to save the changes.

Note: If you cannot log in to Helix ALM web clients, seeWebClients Return a 404-Page Not Found Error.

Configuring Microsoft IIS 6 for Helix ALM Web
After you install the Helix ALM web components, you need to configure the web server before users can log in
to web clients.

See SupportedWeb Servers for information about supportedMicrosoft Internet Information Server (IIS)
versions. Refer the IIS documentation for information about enabling CGI execution and authentication.

Note: If you use IIS 7 or later, see ConfiguringMicrosoft IIS 7 and later for Helix ALMWeb, page 33.

Creating a CGI directory alias

Note: If you are configuring IIS for the Helix ALM License Server Web Admin Utility and Helix ALM Web,
and the CGIs for both applications are in the same directory (e.g., C:\inetpub\scripts), you only need to
create one CGI directory alias.

1. Open IIS Manager.

2. Expand the server computer andWeb Sites nodes.

3. Right-click Default Web Site and chooseNew > Virtual Directory.

The Virtual Directory Creation Wizard opens.

4. Follow the on-screen instructions. Enter the following information when prompted:

n Enter ‘scripts’ as theAlias.

n Set theDirectory to the path that was entered during the Helix ALM installation for the ttcgi.exe
program. The default path is C:\inetpub\scripts.

n Select the followingAccess Permissions: Read, Run scripts, Execute.
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Installing the Helix ALM URL Redirector

5. Click Finish to save the changes.

Enabling the .exe CGI extension
1. In IIS Manager, expand the server computer andWeb Sites nodes and selectWeb Service Extensions.

2. Click Add a new Web service extension in theWeb Service Extensions pane.

3. Enter 'Helix ALM' as theExtension name.

4. Click Add.

5. Enter the path to the ttcgi.exe program and click OK. The default location is C:\inetpub\scripts\ttcgi.exe.

6. Select Set extension status to Allowed.

7. Click OK.

8. Repeat steps 4 through 7 for other web clients you use.

n If you use the web server admin utility, add ttadmcgi.exe.

n If you use SOAP, add ttsoapcgi.exe.

n If you use an external source control provider, such as Git, add ttextpro.exe.

9. Click OK to save the changes.

Enabling Active Server pages
1. In IIS Manager, expandWeb Sites and then clickWeb Service Extensions.

2. In theWeb Service Extensions pane, click Active Server Pages and then click Allow.

3. Restart IIS.

Note: If you cannot log in to Helix ALM web clients, seeWebClients Return a 404-Page Not Found Error.

Installing the Helix ALM URL Redirector
Helix ALM supports ttstudio and http protocols in hyperlinks used to open items, such as issues. The Helix
ALM URLRedirector handles routing of ttstudio hyperlinks and determines if they are opened in the desktop or
web client. Http hyperlinks are always opened in the web client.

By default, ttstudio hyperlinks are opened in the desktop client. If the client is not found, the link is converted
to use the http protocol and opened in the web client.

The redirector is automatically installed during client installations. Web client users must install the redirector
to open ttstudio hyperlinks. Download the installer from the Add-ons page.
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Moving Helix ALM Projects
After installation, youmay want to move existing Helix ALM projects. You canmove projects to another
computer using a network connection, a ZIP drive, or an FTP connection. Keep the following inmind:

n If you are upgrading Helix ALM, you can upgrade projects in the existing location or in the new location. If
you upgrade projects in the existing location, you should wait to move the projects to the new location until
you are sure the upgrade is successful.

n The project database file structure is the same on all operating systems. No special conversion is
necessary.

n On Linux, files in the /var/lib/HelixALM directory must be owned by root. The ttproj.db file needs read-write
permissions to be able to save data. The filename is case sensitive.

Note: The following information only applies to Helix ALM native projects and TestTrack 6.0 and later
native projects.

1. Install Helix ALM and the Helix ALM License Server in the new location.

2. In both locations, stop the Helix ALM Server and the Helix ALM License Server.

It is important to stop the servers in the old location tomake sure the projects are not being written to
when they aremoved.

3. In the old location, make a backup copy of the LicenseServDb directory and all subdirectories in the
license server application directory.

4. In the old location, make a backup copy of the TTDbs directory and all subdirectories in the Helix ALM
application directory.

5. Copy the LicenseServDb directory and all subdirectories in the old location to the license server
application directory in the new location.

6. Copy the TTDbs directory and all subdirectories in the old location to the Helix ALM application directory
in the new location.

7. Start the license server in the new location.

8. Start the Helix ALM Server in the new location.

Note: If you have trouble connecting to the projects in the new location, seeMoving Databases and
Projects.
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Setting Up RDBMS Databases
Helix ALM projects and the server database are stored in a Relational DatabaseManagement System
(RDBMS). SQLite is default, native database format and does not require any setup or configuration before or
after installation. See About Helix ALM databases for information about how Helix ALM data is stored.

Helix ALM data can also be stored in other RDBMS types, which allows you to leverage your existing
database administration process. Microsoft SQL Server (ODBC), Oracle, and PostgreSQL are supported.
See Helix ALM RDBMS Support for information about supported platforms and database versions.

Review the following information for help setting up databases for use with Helix ALM.

n Oracle

n PostgreSQL

n SQL Server

Note: Helix ALM License Server data is stored in a separate database. By default, the license server
database is also stored in SQLite, but other RDBMS types are supported. See the Helix ALM License
Server help for information about setting up license server databases.

Setting up Oracle databases
Perforce does not provide support for installing, configuring, or maintaining Oracle. A qualified Oracle
database administrator should install and configure the database and create the required schemas and
tablespaces.

Keep the following inmind:

n Do not add, delete, or modify any fields in the Helix ALM tables.

n Do not directly add, edit, or delete any data in the tables.

n Do not create different primary keys. This will adversely affect application performance.

n Do not create complex triggers on any of the tables. Triggers may cause severe database issues and
correcting these issues is not covered by Perforce.

n Create a process to back up database tables on a regular schedule.

n Running Oracle and the Helix ALM Server on the same computer can result in slow performance if not
configured correctly. Make sure Oracle is configured correctly to avoid using all the systemmemory.

Connecting to Oracle

The recommendedmethod for using Oracle is via Oracle Call Interface (OCI). Download and install the
required Oracle Instant Client libraries.

Windows installers

n 32-bit

n 64-bit
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Setting up PostgreSQL databases

Linux installers

n 32-bit

n 64-bit

Creating database tables

The Helix ALM Server automatically creates tables when you start the server or convert the server database.
The TTServerDB.sql script file, which is located in the Oracle directory in the Helix ALM application directory,
is used to create the tables.

Creating Oracle users

Youmust create anOracle user for the Helix ALM Server. The user only requires default connection privileges
and should not have any Oracle DBA privileges. Use your preferred tablespacemanagement for the users. An
easy method is to set up the user to share the USERS tablespace and to enable an unlimited quota.

Database character set

Oracle only converts characters when theOracle client’s character set, specified by NLS_LANG, does not
match the character set stored in the database. If the character set is not UTF-8, VARCHAR2 fields may not
be able to correctly store data. If this happens, the followingmisnomer of an error is returned: ‘ORA-01461:
can bind a LONG value only for insert into a LONG column’. TheOracle database character set should be
AL32UTF8 or UTF8.

Sizing, memory, and tuning

Oracle sizing and tuning settings should be consistent with your corporate standards. Review the SQL scripts
for schema creation installed with Helix ALM Server to determine the appropriate settings.

Setting up PostgreSQL databases
Perforce does not provide support for installing, configuring, or maintaining PostgreSQL. A qualified
PostgreSQL database administrator should install and configure the database.

Keep the following inmind:

n Do not add, delete, or modify any fields in the Helix ALM tables.

n Do not directly add, edit, or delete any data in the tables.

n Do not create different primary keys. This will adversely affect application performance.

n Do not create complex triggers on any of the tables. Triggers may cause severe database issues and
correcting these issues is not covered by Perforce.

n Create a process to back up database tables on a regular schedule.

n Running PostgreSQL and the Helix ALM Server on the same computer can result in slow performance if
not configured correctly. Make sure PostgreSQL is configured correctly to avoid using all the system
memory.
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Setting up SQL Server databases

Creating server database tables

The Helix ALM Server automatically creates tables in PostgreSQLwhen you start the server or convert the
server database. The TTServerDB.sql script file, which is located in the PostgreSQL directory in the Helix
ALM application directory, is used to create the tables.

Setting up SQL Server databases
Perforce does not provide support for installing, configuring, or maintaining SQL Server. A qualified SQL
Server database administrator should install and configure the database.

Keep the following inmind:

n Do not add, delete, or modify any fields in the Helix ALM tables.

n Do not directly add, edit, or delete any data in the tables.

n Do not create different primary keys. This will adversely affect application performance.

n Do not create complex triggers on any of the tables. Triggers may cause severe database issues and
correcting these issues is not covered by Perforce.

n Create a process to back up database tables on a regular schedule.

n Running SQL Server and the Helix ALM Server on the same computer can result in slow performance if
not configured correctly. Make sure SQL Server is configured correctly to avoid using all the system
memory.

Note: Youmust be amember of the db_ddladmin role and have the CREATE TABLE, CREATE
PROCEDURE, and CREATE VIEW permissions to create the Helix ALM tables.

Connecting to SQL Server

The only supportedmethod for using SQL Server is via ODBC. After creating the database to use for the Helix
ALM product, add a SQL Server data source name (DSN) on the Helix ALM computer. See Creating DSNs for
SQL Server Databases for information.

Creating server database tables

The Helix ALM Server automatically creates tables when you start the server or convert the server database.
The TTServerDB.sql script file, which is located in the SQLServer directory in the Helix ALM application
directory, is used to create the tables.

Troubleshooting RDBMS connections
The following information can help you troubleshoot commonRDBMS issues. Refer to the database vendor
documentation for additional help.

Note: If the Helix ALM Server cannot connect to the server database, errors are added to the Startup.log
file in the Helix ALM application directory.

Server database cannot be shared
The Helix ALM Server, Helix ALM License Server, and Surround SCM Server and store server configuration
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information in a server database. The server databases cannot be located in the sameRDBMS database.

Dropped tables or change database configuration
Youmust stop and restart the Helix ALM Server if you drop server or tables from anRDBMS and need to re-
create them. Youmust also stop and restart the server if you reconfigure the destination database in the
ODBC Data Source Administrator.

The Helix ALM Server caches data from the database. If the underlying database is modified, the cached data
no longer matches the data in the database. The connection fails if the server identifies that the backend
database is different and the following error is logged: 'The server failed to initialize a connection for XYZ. The
destination RDBMS database was changed'.

Mismatched UUID affects server database lock
This error occurs when the database is in use by a different Helix ALM Server. You are prompted to
reconfigure the database. Do not reconfigure the database if it is used on a different computer. Youmust
manually modify the Helix ALM Server connection information to point to a different database and restart the
server. If the database is no longer in use by a different server, reconfigure the database connection
information to allow the current Helix ALM Server access to the database.

ODBC connection issues
Try the following if you are experiencing ODBC connection problems.

1. Test the ODBC connection in the ODBC Data Source Administrator.

If you cannot connect to the RDBMS, click the Test Connection button in the ODBC Data Source
Administrator to test the connection.

2. Make sure the DSN is a system DSN.

The data source you are trying to connect to must be configured as a system DSN in the ODBC Data
Source Administrator. The Helix ALM Server Admin Utility only displays system DSNs.

ODBC connection errors

Error Cause

[Microsoft][ODBC Driver Manager] Data source
name not found and no default driver specified
QODBC3: Unable to connect

AnODBC data source with the specified DSN was not
set up in the ODBC Data Source Administrator. The
DSN must be a system DSN.

SQL Server connection errors

Error Cause

[Microsoft][ODBC SQLServer Driver][SQL
Server]Login failed for user '(null)'. Reason:
Not associated with a trusted SQL Server
connection. QODBC3: Unable to connect

Occurs onWindows. A username is not specified for the
RDBMS connection and theODBC data source was not
configured to run ‘WithWindows NT authentication using
the network login ID’ in the ODBC Data Source
Administrator.
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Error Cause

[Microsoft][ODBC SQLServer Driver][SQL
Server]Login failed for user 'xxxx'.
QODBC3: Unable to connect

The username or password entered in the RDBMS
connection information is not valid.

Oracle connection errors

Error Cause

ORA-06401: NETCMN:
invalid driver designator
QOCI: Unable to logon

TheOracle Instant client drivers are not installed. See Setting upOracle
databases, page 39 for information about downloading the installers.

ORA-12705: invalid or
unknownNLS
parameter value
specified QOCI: Unable
to logon

The full Oracle client is installed on the same computer with a language setting
other than UTF8. To resolve this issue, set the following environment variable:

n Windows—NLS_LANG=AMERICAN_AMERICA.WE8MSWIN1252

n Linux—NLS_LANG=American_America.UTF8

You can also remove the following registry entry to help resolve the issue: HKEY_
LOCAL_MACHINE\SOFTWARE\ORACLE\NLS_LANG

Note: Refer to Oracle Metalink article 179133.1, “The Correct NLS_LANG in
aWindows Environment,” for information about the correct setting, which
varies based on theWindows version.

ORA-12514:
TNS:listener does not
currently know of
service requested in
connect descriptor
QOCI: Unable to logon

The service name specified in the RDBMS connection information does not
exist. Make sure that an Oracle listener was created with the specified service
name on the host computer.

This error can also occur if a version of the full Oracle client older than 10g is
installed. If the full client appears in the PATH environment variable, the older
oci.dll may be loaded. To resolve this issue, search for all instances of the oci.dll
file. If multiple copies are found, remove the other copies or remove their
directory reference from the PATH environment variable.

ORA-12154: TNS:could
not resolve the connect
identifier specified
QOCI: Unable to logon

The computer specified in the RDBMS connection host name cannot be found.
Make sure the host name is correct and the host computer is running.

ORA-12541: TNS:no
listener QOCI: Unable
to logon

The port number specified in the RDBMS connection information is not a valid
TNS listener port on the specified host computer. Check the host port number.

ORA-01017: invalid
username/password;
logon denied QOCI:
Unable to logon

The username or password specified in the RDBMS connection information is
not valid. Check the username and password.
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PostgreSQL connection errors

Error Cause

Opening the database connection failed because the
Helix ALM Server could not connect to the server or
translate the host name

The Helix ALM Server cannot connect to the
PostgreSQL service. Check the following and
then restart the server:

n The PostgreSQL service is running.

n The host name and port number are correct.

n A firewall is not blocking the port.

n If connecting to a remote PostgreSQL server,
the server is configured to accept remote
connections.
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If there is a problem connecting to the Helix ALM Server or Helix ALM License Server, first check the
following and try reconnecting:

n Make sure the server computer is running.

n Check the IP address and port number.

n Make sure you are connected to the network, intranet, or Internet.

The Helix ALM License Server and Helix ALM Server are not communicating
If the servers are not communicating, make sure the connections are configured correctly.

1. Start the Helix ALM License Server and the Helix ALM Server.

2. Start the Helix ALM Server Admin Utility and log in.

Use the local admin password to log in if your username and password are not recognized. Leave the
username blank and enter admin as the password. This password only provides access to the Helix ALM
License Server configuration.

3. Click Server Options and select the License Server category.

4. Make sure the server address and port number are correct and click Test Connection.

5. If the connection is successful, stop and restart the Helix ALM Server for the changes to take effect.

6. If the connection is not successful, check the following:

n If the Helix ALM Server and the license server are installed on different computers, check your
network and firewall configurations to open the necessary ports.

n Check the communications password on the Helix ALM Server and license server. The same
communications passwordmust be set on both servers. To check the password in the Helix ALM
Server Admin Utility, click Server Options, and then click the License Server category. To check
the password in the Helix ALM License Server Admin Utility, click Server Options, and then click the
Server category.

Users cannot access a Helix ALM area they have a license for
Users may be able to log in to Helix ALM, but may not be able to access issue, requirements, or test case
management functionality. Verify that the project options allow users to log in and check user licenses.

Checking project login options

1. Choose Tools > Administration > Project Options and select theGeneral category.

2. Select any Login Options to allow users to log in to the project.

3. Click OK to save the changes.

Users must restart Helix ALM if any changes weremade. If users still cannot access functionality, make
sure the correct license is assigned.

Checking user licenses

1. Choose View > Users.
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2. Select a user and click Edit.

3. Click the License tab.

4. Verify that user has a license for the area they cannot access. Assign a license if necessary.

5. Click OK to save the changes.

Users must restart Helix ALM if any changes weremade.

'Required public key is not found' message when logging in
If RSA key exchange is enabled on the Helix ALM Server for additional security, a public key must be stored
in the server connection. If the public key is not found or does not match the key on the server, the user cannot
log in.

Helix ALM Client users

Import a server settings XML file provided by the Helix ALM administrator.

Note: The administrator can download the XML file in the server admin utility. See the Server Admin
Utility help for information.

1. Click Setup in the Helix ALM login dialog.

2. If the server connection is new, click Add. If the connection already exists, select it and click Edit.

3. Click Import, select the XML file and, click Open.

The Server address, Port, and Public key fingerprint fields are automatically populated.

4. Click OK to save the changes.

5. Retry the login.

Helix ALM Web users

The Helix ALM administrator must update the CGI settings on the Helix ALM Server. See the Registry Utility
help for information.

Users cannot log in to Helix ALM Web
If users cannot log in to Helix ALM Web, make sure they have the security permissions to log in using web
clients.

1. Choose View > Security Groups.

2. Select the user's security group and click Edit.

3. Select General in the Command Security category.

4. Verify that theAllow Login Via Helix ALM Web command is selected.

5. Click OK to save the changes.

6. Retry the login.

Web clients return a '404 - Page Not Found' error
Helix ALM Web and the Helix ALM Web Server Admin Utility need access to the CGI directory and the CGI
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executables. This error usually occurs for one of the following reasons:

n The directory and executable do not exist or cannot be accessed

n The directory and executable location has changed

n The .exe extension is prohibited (IIS 6.0 only)

n URLScan is running (IIS only)

SeeWebClients Returns a 404-Page Not Found Error for information about resolving the error.

Server is not available in the login dialog box
To access a project, the Helix ALM Client must connect to a Helix ALM Server. Users need to set up a server
connection if the server that contains the project is not available in the Server list in the login dialog box.

1. Click Setup in the Helix ALM login dialog box.

2. Click Add in the Setup Server Connections dialog box.

3. Enter aServer Name, Server Address, and Port number.

Tip: If the server is installed on the same computer as the Helix ALM Client, enter ‘localhost’ or
‘127.0.0.1’ for the server address.

4. Click OK to add the server connection.

Project is not available in the Projects list
The Projects list in the Helix ALM Project Selection dialog box only contains the projects that users have
access to. If users do not have access, the Helix ALM administrator must add them to the project.

1. Log in to the project.

2. ChooseView > Users.

3. Click Add to add a new user or click Retrieve Global User to add global users from the Helix ALM
License Server.
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Appendix A: Microsoft Windows Security
Issues

File level security issues

Helix ALM can only restrict security access through the application. This does not replace the need for file and
directory security at the operating system level.

UseWindows NT/2000 with NTFS to provide increased security. You can restrict access to the Helix ALM
directory through NTFS security settings. You can also restrict access for most users to read-only
permission. Users do not need write access because the server application does the actual writing to the
project files.

The following example illustrates what could happen if users have full access:

A drive is accessible through the network and there is no file-level security on the drive. Any user can open
and look at data/files using a program such as Notepad. Data is stored in both binary format and plain text.
Usernames and passwords are encrypted so the user cannot access that information. In addition to viewing
the data/files, it is possible for a user to vandalize your system by deleting files or even deleting an entire
project.

Note:Windows 2000 with FAT provides some security restrictions. However, Windows NT/2000 with
NTFS is recommended if security is a concern.

Directory sharing issues

n The Helix ALMODBC driver requires projects to be accessible via a shared network drive. You only need
to share the Helix ALM directory if you are planning to use the ODBC driver.

n If you grant ODBC access to a project, users can view all Helix ALM data with the exception of encrypted
usernames and passwords.

n The need for file-level security is increased if you place the Helix ALM project on a shared network drive.

Note:Windows XP does not provide file-level security because it uses the FAT file system. Windows NT
security is only available if you are using the NTFS file system; it is not available with the FAT file system.
You can convert to NTFS. Refer to theMicrosoft Windows documentation for additional information.
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D3.js license

The following license information applies specifically to the D3 software.

Copyright (c) 2010-2014, Michael Bostock

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions aremet:

n Redistributions of source codemust retain the above copyright notice, this list of conditions and the
following disclaimer.

n Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

n The nameMichael Bostock may not be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NOEVENT SHALLMICHAEL BOSTOCK BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDINGNEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUTOF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

FreeType license

Software from the FreeType project is used under the FreeType Project License.

Portions of this software are copyright © 2013 The FreeType Project (www.freetype.org). All rights
reserved.

gSOAP software license

The following license information applies specifically to the gSOAP software.

Part of the software embedded in this product is gSOAP software.

Portions created by gSOAP are Copyright (C) 2001-2002 Robert A. van Engelen, Florida State University. All
Rights Reserved.
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THE SOFTWARE IN THIS PRODUCTWAS IN PART PROVIDED BY GSOAP SOFTWARE AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NOEVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDINGNEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUTOF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

MIT Kerberos

This product includes Kerberos software developed by theMassachusetts Institute of Technology
(http://web.mit.edu/kerberos/):

Copyright 1997-2004 by theMassachusetts Institute of Technology. All rights reserved.

THIS SOFTWARE IS PROVIDED "AS IS", AND M.I.T. MAKES NOREPRESENTATIONS OR
WARRANTIES, EXPRESS OR IMPLIED. By way of example, but not limitation, M.I.T. MAKES NO
REPRESENTATIONS OR WARRANTIES OFMERCHANTABILITY OR FITNESS FOR ANY
PARTICULAR PURPOSE OR THAT THE USE OF THE LICENSED SOFTWARE OR DOCUMENTATION
WILL NOT INFRINGE ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER
RIGHTS.

Node.js license

A copy of the Node.js license is available in the Node_License.txt file in the Helix ALM application directory.

OpenLDAP license

The following license information pertains specifically to the OpenLDAP software.

TheOpenLDAP Public License

Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation ("Software"), with or without
modification, are permitted provided that the following conditions aremet:

1. Redistributions in source formmust retain copyright statements and notices,

2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list of
conditions, and the following disclaimer in the documentation and/or other materials provided with the
distribution, and

3. Redistributions must contain a verbatim copy of this document.

TheOpenLDAP Foundationmay revise this license from time to time. Each revision is distinguished by a
version number. Youmay use this Software under terms of this license revision or under the terms of any
subsequent revision of the license.
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THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS CONTRIBUTORS ``AS
IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NOEVENT SHALL THE OPENLDAP FOUNDATION, ITS CONTRIBUTORS, OR THE
AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDINGNEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUTOF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in advertising or otherwise to promote the
sale, use or other dealing in this Software without specific, written prior permission. Title to copyright in this
Software shall at all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Copyright 1999-2003 TheOpenLDAP Foundation, Redwood City, California, USA. All Rights Reserved.
Permission to copy and distribute verbatim copies of this document is granted.

OpenSSL license

The following license information applies specifically to the OpenSSL toolkit.

TheOpenSSL toolkit stays under a double license, i.e. both the conditions of the OpenSSL License and the
original SSLeay license apply to the toolkit. See below for the actual license texts.

OpenSSL license

Copyright (c) 1998-2017 TheOpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions aremet:

1. Redistributions of source codemust retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertisingmaterials mentioning features or use of this softwaremust display the following
acknowledgment: "This product includes software developed by the OpenSSL Project for use in the
OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products
derived from this software without prior written permission. For written permission, please contact
openssl-core@openssl.org.

5. Products derived from this softwaremay not be called "OpenSSL" nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product
includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)"
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THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDINGNEGLIGENCE
OR OTHERWISE) ARISING IN ANYWAY OUTOF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

====================================================================

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay license

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was
written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are aheared to.
The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc.,
code; not just the SSL code. The SSL documentation included with this distribution is covered by the same
copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed.

If this package is used in a product, Eric Young should be given attribution as the author of the parts of the
library used.

This can be in the form of a textual message at program startup or in documentation (online or textual)
provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions aremet:

1. Redistributions of source codemust retain the copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertisingmaterials mentioning features or use of this softwaremust display the following
acknowledgement: "This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library being used
are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application
code) youmust include an acknowledgement: "This product includes software written by Tim Hudson
(tjh@cryptsoft.com)"
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THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDINGNEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUTOF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution licence [including the GNU
Public Licence.]

Oracle JRE

A copy of the Oracle JRE copyright file and the third-party license file is installed in the JRE subdirectory with
the Oracle Standard Edition Java Runtime Environment redistributable files. The following license information
applies specifically to the Oracle JRE.

Use of the Commercial Features for any commercial or production purpose requires a separate license from
Oracle. “Commercial Features” means those features identified Table 1-1 (Commercial Features In Java SE
Product Editions) of the Java SE documentation accessible at
http://www.oracle.com/technetwork/java/javase/documentation/index.html

Qt LGPL license

Helix ALM uses the Qt library covered by version 2.1 of the GNU Lesser General Public License (LGPL). A
copy of the Qt LGPL license is available in the Qt License.txt file in the Helix ALM application directory.

Stanford JavaScript Crypto Library

Copyright 2009-2010 Emily Stark, Mike Hamburg, Dan Boneh.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions aremet:

1. Redistributions of source codemust retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
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THIS SOFTWARE IS PROVIDED BY THE AUTHORS "AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL <COPYRIGHT HOLDER> OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDINGNEGLIGENCE
OR OTHERWISE) ARISING IN ANYWAY OUTOF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

The views and conclusions contained in the software and documentation are those of the authors and should
not be interpreted as representing official policies, either expressed or implied, of the authors.

SVGPathSeg polyfill license

Copyright 2015 The Chromium Authors. All rights reserved.

The Chromium Authors can be found at http://src.chromium.org/svn/trunk/src/AUTHORS

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions aremet:

n Redistributions of source codemust retain the above copyright notice, this list of conditions and the
following disclaimer.

n Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

n Neither the name of Google Inc. nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NOEVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANYWAY OUTOF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

TinyMCE license

TinyMCE software is used under version 2.1 of the GNU Lesser General Public License (LGPL). A copy of the
LGPL license is available in the Helix ALM application directory.

A copy of the TinyMCE source code can be obtained from the following location:
https://github.com/FernCreek/tinymce

Xerces license

The following license information pertains specifically to the Xerces software.

Copyright 1999-2004 The Apache Software Foundation.
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Licensed under the Apache License, Version 2.0 (the "License"); youmay not use this file except in
compliance with the License. Youmay obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed
on an "AS IS" BASIS, WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND, either express or
implied. See the License for the specific language governing permissions and limitations under the License.

======================================================
== NOTICE file corresponding to section 4(d) of the Apache License,
== Version 2.0, in this case for the Apache Xerces distribution.
======================================================

This product includes software developed by The Apache Software Foundation (http://www.apache.org/).
Portions of this software were originally based on the following:

- software copyright (c) 1999, IBM Corporation., http://www.ibm.com

Software under the Apache license, version 2.0

The following software components are used under the Apache License, Version 2.0.

Diff Match and Patch Copyright 2008Google Inc. All Rights Reserved.
Author: fraser@google.com (Neil Fraser)
Author: mikeslemmer@gmail.com (Mike Slemmer)

Gson Copyright 2008Google Inc.

Mousetrap Copyright 2013 Craig Campbell

prettify Copyright (C) 2006Google Inc.

XALAN-C Copyright (c) 1999-2012 The Apache Software Foundation

Licensed under the Apache License, Version 2.0 (the "License"); youmay not use this file except in
compliance with the License. Youmay obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed
on an "AS IS" BASIS, WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND, either express or
implied. See the License for the specific language governing permissions and limitations under the License.

Software under the MIT license

The following software components are used under theMIT License.

AngularJS Copyright (c) 2010-2014Google, Inc. http://angularjs.org

bluebird Copyright (c) 2014 Petka Antonov

CodeMirror Copyright (C) 2013 by Marijn Haverbeke <marijnh@gmail.com> and others
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C3 Copyright (c) 2013Masayuki Tanaka

es5-sham/es5-
shim

Copyright (C) 2009-2016 Kristopher Michael Kowal and contributors

Globalize Copyright jQuery Foundation and other contributors, https://jquery.org/

jQuery Copyright 2012 jQuery Foundation and other contributors http://jquery.com/

jquery-textfill Copyright (c) 2014 Alexandre Dantas
Copyright (c) 2012-2013 Yu-Jie Lin
Copyright (c) 2009 Russ Painter

jstz Copyright (c) 2012 Jon Nylander, project maintained at
https://bitbucket.org/pellepim/jstimezonedetect

lodash.js Copyright jQuery Foundation and other contributors <https://jquery.org/>

Moment.js Copyright (c) 2011-2014 TimWood, Iskren Chernev, Moment.js contributors

ng-grid Copyright (c) 2012 the AngularUI Team, http://angular-ui.github.com

Raphael vector
library

Copyright (c) 2008-2011 Dmitry Baranovskiy (http://raphaeljs.com)
Copyright (c) 2008-2011 Sencha Labs (http://sencha.com)

scrollbar-width.js Copyright (c) 2014Olmo Kramer

spin.js Copyright (c) 2011-2015 Felix Gnass [fgnass at gmail dot com]

SproutCore Copyright: (c) 2006-2009 Sprout Systems, Inc. and contributors.
Portions (c) 2008-2009 Apple Inc. All rights reserved.

SPTable 2010-2012 Christopher Swasey (@Endash)
2006-2011 Strobe Inc. and contributors.
2008-2012 Apple Inc. All rights reserved.

trunk8 Copyright 2012 Rick Viscomi

vswhere Copyright (C) Microsoft Corporation. All rights reserved.

TheMIT License (MIT)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of
the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDINGBUT NOT LIMITED TO THEWARRANTIES OFMERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NOEVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OFOR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Other software

When source code is installed to the local hard drive as part of the product installation, the license agreement
for that source code is stored in the directory along with the third party source code (e.g., distributed Node.js
components in the ExternalIntegrationService subdirectory).

Licenses for those components are not duplicated in this document because the license is installed with the
source code.
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